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This manual is divided into three sections, a Preface, a User Guide and a Reference section.

The Preface contains information all users should be sure to read. Installation details and a 
general introduction appear here, as well as hints and tips for organizing your disks to work 
well with SmartCat's approach.

The User Guide presents a guided tour of SmartCat's features and facilities and covers most 
of the things a new user will need to know to be comfortable with SmartCat for day-to-day 
use. The user guide is designed in the form of an exercise you can follow at your PC while 
actually using SmartCat. Have a blank pre-formatted floppy disk ready (any density will do).

The reference section provides more in-depth explanations of each of SmartCat's menu items 
and commands, a list of Keyboard shortcuts, and instructions for customizing SmartCat and 
performing  problem  determination.  Every  user  should  read  this  section  once  they  are 
comfortable with the concepts presented in the User Guide.   

This is the Shareware version of the manual. The registered version includes screen shots 
during each step of the guided tour.
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Disclaimer

Welcome to  SmartCat.  SmartCat  is  a  sophisticated  disk  cataloging  system for  Microsoft 
Windows.

This software is supplied as is without warranty or representation either express or 
implied  with  respect  to  the  program  or  its  documentation  including  their  quality, 
performance, merchantability, or fitness for a particular purpose. 

In no event will Oakley Data Services be liable for direct, indirect, special, incidental, or 
consequential damages arising out of the use of or inability to use the program.

All trademarks are acknowledged. 
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Installation

If you received this product on disk there should have been an INSTALL.EXE program on the 
disk. If you execute that program from either the File Manager or Program Manager it will lead 
you through the installation process, including  de-compressing and copying the required files 
and creating a Program Manager group for SmartCat. 

If you do not have the INSTALL.EXE file you will need to copy the files manually onto your 
hard drive and create a Program Manager group and Icon for SmartCat. The following is a 
workable scheme for positioning the required files:-

SMARTCAT.EXE - to any directory of your choosing
SMARTCAT.WRI - to the same directory as above
README.TXT - to the same directory as above
ORDRFORM.TXT - to the same directory as above
SMARTCAT.HLP - to your Windows Directory
BWCC.DLL - to your Windows Directory
SMCATDOS.PIF - to your Windows Directory
SMCATDOS.BAT - to your Windows Directory
SMARTCAT.INI - to your Windows Directory

Instructions for creating a Program Manager Group and Program Icon manually are in your 
Windows  Documentation  in  the  chapter  covering  the  Program  Manager  in  the  sections 
"Creating and Deleting Groups" and "Changing the Contents of Groups".
 
Please be sure to take the time to read the .TXT files that came on the disk. They contain  
information that is not always repeated elsewhere. You can use the Notepad program from 
the Windows Accessories group to view the files.
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Introduction 
Categorising your disks 

Getting the best from SmartCat needs some thought about the best way to organize your 
collection of floppy disks. Even if you only have a few floppy disks now, it won't be long before 
your collection grows substantially.

Whilst SmartCat doesn't have any particular limit to the number of disks it will catalog in a 
single catalog (apart from the amount of memory you have, and the amount of disk space 
available to store the catalog) it probably isn't sensible to keep all your disks cataloged in one 
catalog. We would suggest you catalog your disks based on their "category". Some of your 
disks  will  have  come  from  Software  Manufacturers,  such  as  your  DOS  and  Windows 
distribution disks, and you are never likely to write new or amended files to them. Others will 
be  disks  that  have  come from Shareware  libraries,  and  again  writing  to  them would  be 
unlikely. Others may have come from magazine cover disks, and would form a logical third 
category. Then there will be those that you use as working disks, and perhaps others you 
keep customer data/work on. 

We would suggest that you divide your catalogs based on the categories you consider most 
sensible for your particular way of working. SmartCat supports the merging of catalogs for 
searching and reporting purposes, so you can always simulate a single catalog if you need to. 

Labeling your Disks 

SmartCat doesn't  print  disk labels.  We suggest you simply write the volume number that 
SmartCat allocates the disk when you catalog it onto the original label with a felt tip pen or  
similar. If you then store your floppies in numerical order within category it will be a simple 
task to find any one of them. Alternatively, most stationers sell small, nicely printed stick-on 
labels in ascending numerical sequence which you can stick discreetly over a corner of the 
original label. 

Copyright © 1992 by Oakley Data Services - All rights reserved.
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First Steps

Be Prepared

If you intend to follow this guide through on your PC, have a blank pre-formatted floppy disk  
ready (any size will do). We will perform most of SmartCat's functions using your hard disk. 
Although your major use of  SmartCat will  probably be to keep track of  your collection of 
floppies, because you are running Windows there are files that are bound to be on your hard 
disk that will ensure the guided tour is appropriate to you.

Starting SmartCat

The first thing to do is to start SmartCat, so double-click on the SmartCat Icon, and after any 
introductory screens SmartCat's main window will appear.
 
The outer  window is known as the "frame window",  and inside it  (with the caption "New 
Catalog") is a "child window". SmartCat uses three different sorts of child windows, a catalog 
window, a  disk window and a  search window,  and we will  meet  them all  as we explore 
SmartCat's facilities. There can only be one  catalog window,  but there can be many  disk 
windows and search windows. 

As well as being able to minimize the whole SmartCat Application by pressing the down arrow 
in  the  top  right  corner  of  the  frame  window,  because  SmartCat is  an  MDI  compliant 
application, you can also minimize the individual child windows. Try it now by pressing the 
down arrow at the top right of the catalog window. Then return the Icon to a normal window by 
either  double-clicking  on  it  or  single  clicking  and  selecting  the  Restore option  from  the 
resultant floating Menu. 

It is worth making sure you understand how to manage windows in an MDI application, so if  
you are unsure please read the "Two Kinds of Windows" section of the "Basic Skills" chapter 
of your Windows Documentation. 

As it stands, SmartCat displaying an empty Catalog Window is not very interesting. What we 
need to do is catalog a disk.
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Cataloging a Disk

Select the  Add Disk menu item from the  Maintain drop down menu, and a dialog box will 
appear.

In the "Drives" list box in the top left hand corner select the hard drive which contains your 
Windows  Directory  (probably  "C").  Ensure  "permit"  is  selected  as  the  "Unlabelled  disks" 
option, "verbose" is checked for the "reporting mode", all the "archive analysis" boxes are 
checked, and "preliminary virus scan" is set to "no". Then press the OK button and SmartCat 
will proceed to read your hard disk and catalog all the files on it.

Each file will be listed in the window at the bottom of the Dialog Box as it is cataloged, as will  
the content of any archive files on your hard disk. The final message in the window will be 
"Disk 1 cataloged". 

The Dialog Box will not go away however, and you need to press the Cancel button. If you 
were cataloging floppy disks you could simply insert another floppy and click on OK to catalog 
a second disk, and keep repeating the process until you reached the end of the pile.

Your display will now be showing a single line in the  catalog window. From left to right the 
fields  displayed  are;  the  disk  number  as  assigned  by  SmartCat;  the  disk's  label  (or 
[Unlabelled]) if it has no label; the size of the disk in bytes; the free space in bytes; the date 
and time of cataloging and the drive used for cataloging. There may be a horizontal scroll bar 
along the bottom of the catalog window to allow you to see anything off to the right (unless of 
course you are lucky enough to have a large monitor).

Listing the files on a disk

Now we have a cataloged disk we can start  to use SmartCat to find various files and to 
process them. Let us start with a simple choice, listing all the files on a disk. There are two 
ways to list all the files on a disk. Either select the disk by clicking on it once in the catalog 
window (it willl then highlight) and select the "Volume Contents" menu option from the "View" 
menu, or more simply double-click on the disk in the catalog window. As we only have one 
cataloged disk, double-click on it and a new disk window will appear after a few seconds.

From left to right the fields show; the filename; the file size in bytes; the file date and file time; 
the drive used to catalog it and the file's path from the root directory of the disk.

As before you can scroll right to see any information out of view, and up and down to see 
more files. 

There is a limit to the number of entries that SmartCat will list (not maintain) of 3,000 in any  
child window, and it is possible that your hard disk may contain more files than that in which 
case you will have got a warning message and a partial list. It is unlikely that you would make 
sense of such a large list anyway, but this is ideal for experimentation. 

Sorting the list 

At this point it might be interesting to sort the list of files into different orders. Remember, this 
is a Disk Window, so we need to specify the order we want the Disk Window to display in.

Select  the  "Options  Menu",  and  then  the  "Disk  Sort  Order"  submenu,  and  you  will  be 
presented with five possible choices for the order you want the files listed. Experiment with 
the different choices, noting the way the display changes. Each sort may take a few seconds 
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if the list is extremely large - on floppy disks such sorts are usually instantaneous.
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Statistics

Now make sure the  Disk Window "has the focus" (has a highlighted title bar, and is at the 
front - click somewhere on the  Disk Window if necessary) and select the "Statistics" option 
from the "View" menu. A display giving statistics about the selected disk will appear.

The "Statistics" option is one that affects the window which has the focus. Try clicking on the 
Catalog Window to give it the focus (its title bar will highlight and it will move to the front) and 
select the statistics option again. This time a different display will  appear, giving statistics 
about the whole catalog. 

Searching the Catalog

Let's now try finding some files using SmartCat's sophisticated searching facilities. Select The 
"Search" menu item, and then select the "Simple Search.." option. A dialog box will appear.

Enter  W*.EXE  into  the  dialog  and  press  the  OK  button.  A status  dialog  with  a  moving 
percentage bar will appear and display the progress of the search, at the end of which a new 
child window, a  Search Window will appear. The  Search Window will display all those files 
that  met  the  "search  argument"  (W*.EXE)  that  you  entered.   Note  the  * in  the  search 
argument. The * is known as a "Wildcard" and means "any sequence of characters from here 
to the end of this section of the filename". The other possible Wildcard is a ?, which means 
"any single character in this position". See your Dos documentation for more details about 
wildcards.

Again, you can sort the list of files in the Search Window by using the "Search Sort Order" 
suboption of the "Options" menu.

More Complex Searches 

If  the simple search option doesn't  narrow the list  down sufficiently,  you can undertake a 
"complex" search which additionally  allows you to specify  ranges of  dates and file  sizes. 
Select the "Complex Search..." option from the "Search" menu, and a different Dialog Box will  
appear.

Enter *.* as the filename pattern, 200000 as the minimum size and 300000 as the maximum 
size, and press the OK button. A further search window will appear showing those files in the 
catalog with a size of between 200000 and 300000 bytes.

Adding Comments to Disks

Let's now go back and add a comment to this disk we have cataloged. Click on the Catalog 
Window to give it the focus. Make sure the one cataloged disk is still selected (i.e. highlighted) 
and select the "Modify Comment"" option from the "Maintain" menu. A dialog box will appear.

Enter a suitable comment (up to 30 characters - the Dialog Box will beep if you try to enter 
more) and click on the OK button. The comment will be added to the SmartCat database, but 
you won't be able to see it yet. What you now need to do is select the "Catalog Display Style" 
option  from the  "Options  Menu"  and select  the  "Disk  Comments"  choice.  The listing  will 
change to display the comment instead of the disk's size, free space etc.

Copyright © 1992 by Oakley Data Services - All rights reserved.



SmartCat Release 1.10Page   11  

Managing Windows

At this point the display might be starting to get a bit messy. To clear it up, and allow for a little 
experimentation,  select  the  "Window"  menu,  then  the  "Tile"  option,  and  see  how  the 
arrangement of the child windows changes. Then try the "Cascade" option, and finally choose 
the "Minimize all  windows" option.  Next we are going to experiment with SmartCat's File 
processing capabilities and we will need a list of files, so double click on the Simple: W*.EXE 
Icon to restore just that child window and use the "cascade" option of the "Window" menu to 
have it assume a reasonable size. 

Processing Files

You should be able to find the "WINHELP.EXE" file somewhere in the list (it is the program 
that drives the Windows Help facility), so scroll up and down using the scroll bars to the right 
of the window until it comes into view.

There are two ways to indicate that you wish to process the file. Either single click on it and  
select "Process File..." from the "Maintain" menu, or double-click on the file. Whichever way 
you choose a dialog box will appear. 

Put the blank floppy (not write protected) you prepared earlier into a floppy drive (probably 
"A"), and using the list box at the top left, select that drive so that it appears in the "Target  
Path Specification:-". Then press the "Copy" button and the file will be copied to the floppy, 
with a progress indicator showing percentage complete.

Double-click again on the WINHELP.EXE file in the Search Window, but this time when the 
Dialog Box appears press the "Run" button, and the Windows Help Program will start. 

Of course you would be more likely to use these facilities to copy files from floppies to your 
hard disk. We don't know what is on your floppies, but if you use SmartCat at least you will!

For a discussion of what the other buttons do please refer to the reference section. Even if  
you think they are obvious it is worth reading the reference section, because their actions 
may change if the file they are dealing with is in an archive, or is itself an archive.

Saving the Catalog Data 

Having gone to all this effort you should now save the catalog data, ready for recall whenever 
required. Apart from anything else, you will need to save it now to enable you to proceed with 
the tour because our next step will be to merge the example catalog with the catalog you 
have just created, and SmartCat will not allow you to merge a catalog into one which has 
been modified and not saved. Select the "Save Catalog As..." option from the "File" menu and 
the file saving dialog box will appear.

Locate a suitable directory and enter a suitable name for the catalog (TEST.CAT is probably 
as good as any) and press the OK button and the catalog data will be saved. Then select the 
"New Catalog" option from the "File" menu, and all the catalog data will be cleared (although 
you of course have a copy on disk in the "TEST.CAT" file).

Now select the "Open Catalog..." option from the File menu, and using the displayed Dialog 
Box locate the file you saved and click on O.K.  The catalog will then be reloaded. 
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Merging Catalogs

SmartCat  allows you to  maintain  separate  catalogs  for  different  categories  of  disks,  and 
merge them together for searching or reporting purposes, and that is what we will do now. 
Whilst you have only created one catalog, an example catalog was supplied with the product, 
and we will merge that with your catalog.

Select the "Merge Catalog..." option from the "File" menu and using the resultant dialog box 
locate the supplied example catalog (it has the name EXAMPLE.CAT and would have been 
installed in the same directory as the SmartCat program). Then press the OK button and the 
example catalog will be merged with yours.

The additional disks displayed are in fact a selection of disks supplied on the covers of UK 
computer magazines. Notice that the disk numbering scheme displayed has now changed, 
and the original disk has the prefix A, whilst the new disks show the prefix B. 

It is possible to merge up to 25 catalogs in this manner, which would soon leave you confused 
as to which letter related to which catalog, so there is an option to display a correlation dialog 
to jog your memory. Select the "Merge File Correlation" option from the "View" Menu and a 
Dialog Box will appear to correlate prefixes to catalogs.

Exporting and Printing Data

All  that is left  now on our tour is to try exporting data to the Windows Clipboard, and to  
produce some reports.

With the duplicate listing still with the focus, select the "Copy" option from the "Edit" menu. 
The cursor  will  turn to  an hourglass,  and quickly  back to  an arrow.  If  you now start  the 
Windows Clipboard Viewer program (usually in the Main Group in Program Manager), you 
should see the listing on the Clipboard 

Because the Clipboard Viewer uses a proportional font by default,  the listing may appear 
"wiggly". If you need to you can select the "OEM Text" option from the "Display" menu of the 
Clipboard Viewer to force it to use a non-proportional font. 

You might also like to try pasting this information into another program like Microsoft Write. 
Start the Write program (usually in the Accessories group in Program Manager) and select the 
"Paste" option from the "Edit" menu of the Write program. The listing will appear in the Write 
document.  

Back at SmartCat, with the duplicates list still with the focus, select the "Print" option from the 
"File"  menu,  and a report  of  the list  in  the  Search Window will  be sent  to  the printer.  A 
progress dialog is displayed from which the listing can be cancelled if necessary. 

There is also the option to call the printer's "Setup" dialog by selecting the "Setup Printer..." 
option of the "File" menu. Owners of Laser printers such as the HP Laserjet Series might like 
to try printing in landscape mode.

Now click on the Catalog Window (which now has the caption "Merged Catalog") to bring it to 
the front with the focus, and try printing again. Notice the difference in the report. This time it 
is a listing of the Disks in the catalog. Both the Copying to Clipboard and Printing functions 
use the details from the window which has the focus. They also determine the order they will 
print/copy the listing from the sort order of the Window with the focus. Try sorting the duplicate 
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list (a Search Window) by filesize and then printing it for an example.
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Other Facilities

We haven't explored all of SmartCat's facilities in this short tour, but we hope we have given 
you enough of a feel for the program to be able to use it effectively for your day to day needs. 
The reference section contains full details of all SmartCat's commands and facilities, together 
with further technical details and a more in-depth discussion of some points.

In particular, most users will find a need to understand SmartCat's optional Virus Scanning 
feature (we strongly recommend that you check "foreign" disks for viruses). 

It wasn't possible for us to show how SmartCat lists files in and extracts files from archives, 
because we couldn't guarantee you would have an archive file. You might like to try searching 
the catalog you have created for files using search arguments of *.ZIP, *.LZH, *.PAK, *.ARJ or  
*.ARC, and then selecting one and choosing the "Archive Internals"  option of  the "View" 
menu. When you get the list of files in an archive try processing the file and pressing the 
"extract" button.  Note that files which are in archives display using a different, usually light-
grey color. SmartCat uses the "disabled text" setting from the color option of the Windows 
Control Panel utility for files in archives.

As  you  become  more  confident  with  SmartCat  you  will  probably  want  to  know  how  to 
customise it. Most people wish they could automatically do some process with a file on a 
floppy disk, like pass it to a particular program for printing in some fancy way, or spellchecking 
or whatever, and with SmartCat's customisation facilities, now you probably can!  Full details 
of how to customise SmartCat are in the reference section that follows.
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Keyboard Usage 

The following keyboard shortcuts are supported:- 

Edit - Copy to Clipboard - SHIFT + INS 

Maintain - Add Disk - CTRL+A 
Maintain - Delete Disk - CTRL+D 
Maintain - Update Disk - CTRL+U 
Maintain - Renumber Disk - CTRL+R 
Maintain - Modify Comment - CTRL+C 
Maintain - Process File - Enter 

View - Volume Contents - CTRL+V 
View - Archive Internals - CTRL+I 
View - Statistics - CTRL+S 
View - Merge File Correlation - CTRL+M 

Search - Simple Search - ALT+S 
Search - Complex Search - ALT+C 
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File Menu Commands 

New Catalog 

Selecting New Catalog clears the current Catalog. If there are any unsaved changes a prompt 
is issued to allow the catalog to be saved if required. 

Open Catalog 

Selecting Open Catalog presents a dialog box from which a catalog stored on disk can be 
loaded. If a catalog is currently open and  there are any unsaved changes a prompt is issued 
to allow the current catalog to be saved if required. 

Save Catalog 

Selecting Save Catalog saves the current catalog to disk. The catalog remains open and you 
can continue to work on it.  

Save Catalog As 

Selecting Save Catalog As presents a dialog box in which specifications of where the current 
catalog should be saved can be entered. 

Merge Catalog 

Selecting Merge Catalog presents a dialog box from which a catalog stored on disk can be 
specified. That catalog is then merged with the current catalog. There are certain restrictions 
when the current catalog is the result of one or more merge operations. For a more detailed 
description of these restrictions refer to the section Merged Catalogs . Note that there is a 
limit of  24 on the number of consecutive merge operations 

Printer Setup 

Selecting Printer Setup presents the usual Printer Setup dialog box for the currently selected 
printer.  To  change the  currently  selected  printer  use  the  Printers  option  of  the  Windows 
Control Panel. 

Print 

Selecting Print will cause the details in the currently active window to be sent to the printer. If  
for  example  a  Disk  Window,  containing  details  of  the  contents  of  a  cataloged disk,  was 
currently the front window then those details would be sent to the printer. The print will be in 
the same sort order as the data displayed in the window. For details of how to modify the 
sorting order refer to the options menu command. 

Exit 

Selecting Exit  will  terminate the program. If  there is  any unsaved data a warning will  be 
presented and the option to save the data given. 
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Edit Menu Commands 

Copy 

Selecting  the  Copy  command  will  copy  the  contents  of  the  current  front  window to  the 
Windows Clipboard . If, for example, a Disk Window containing details of the contents of a 
cataloged  disk,  was  currently  the  front  window then  those  details  would  be  sent  to  the 
Clipboard.  The data will  be placed on the Clipboard in  the same sort  order  as the data 
displayed in the window. For details of how to modify the sorting order refer to the options 
menu command. 
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Maintain Menu Commands 

Add Disk 

Selecting the Add Disk command causes the Add Disk Dialog Box to appear. The dialog box 
has options for specifying :- 

Whether to analyse the internal contents of ZIP,ARC,ARJ,LZH and PAK format archive 
files. Each archive type is presented as an on-off toggle option, and clicking on it with the 
mouse will  switch its state.  We would expect you would usually want to select  these 
options, but there may be times when a corrupt archive may cause problems and it will be 
necessary to prevent SmartCat from attempting to read it (although if it is defective it may 
be more sensible to delete it or fix it!). 

Whether  to  permit  or  query  unlabelled  disks.  If  you  select  query  then an  attempt  to 
catalog a disk which is unlabelled produces a further dialog box, from which you can 
select to label the disk, allow it to be cataloged without a label, or cancel the cataloging 
operation.  Choosing  to  permit  unlabelled  disks  causes  the  disk  to  be  cataloged  as 
[unlabelled]. Allowing the cataloging of multiple unlabelled disks slightly increases the risk 
of processing an incorrect file. 

The Reporting Mode required. If set to "verbose" each file encountered is reported in the 
message area at the bottom of the dialog box. If set to "quiet" no files are reported. If set 
to "auto" files are reported when cataloging disks on drives "a" and "b", but not otherwise.  
Updating the message area for each file can slow down cataloging a hard drive quite 
considerably, but can be very useful for problem determination purposes. 

If a preliminary Virus Scan is required. If set to "yes" a Virus Scanning program will be 
called  before  the  disk  is  cataloged.  The  choice  of  virus  scanning  program  is  user 
configurable, and further details can be found in the customization options section. 

Clicking on "OK" then causes SmartCat to read the volume label of the disk. If an unlabelled 
disk is found and the Unlabelled disk query option was selected the option to continue, label 
the disk, or cancel the process is given. The current catalog is then searched for a disk with a  
duplicate label, and if one is found the options to continue or cancel are presented. Assuming 
continue,  or  no  duplicates,  the  directories  on  the  disk  are  read  and  each  file  found  is 
cataloged. If requested, the contents of Archive files are also cataloged. 

When the disk is cataloged the dialog box remains on screen, ready for another disk to be 
inserted and cataloged. When all disks have been cataloged the "Cancel" button should be 
selected to end the process. 

Delete Disk 

Selecting the Delete Disk command removes from the catalog the disk which is currently 
selected in the  catalog window . A confirmation box is presented giving you a final chance to 
confirm the action. If the disk is on a removeable drive (i.e. a floppy) and you delete it from 
the catalog you will be given the option to format the disk. If you elect to do so make sure you 
put the correct disk in the drive! 

Update Disk 

Selecting the Update Disk command displays the same dialog box as in  the "Add Disk" 
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command. Having chosen the required options and pressed the "OK" button, the volume label 
of  the disk in the drive is compared to the catalog record for the disk which is currently  
selected in the catalog window . Assuming the labels match the disk is then processed as for 
the "Add Disk" command, and the records for the disk replace those originally in the catalog. 

Renumber Disk 

Selecting the Renumber Disk allows you to change the catalog number of the disk which is 
currently selected in the catalog window . A dialog is presented which allows you to enter a 
new number. Providing the number you select does not already exist it will replace the current 
volume number. The volume number must lie in the range 1 - 9999. 

Modify Comment 

Selecting Modify Comment allows you to add, delete or change the disk comment associated 
with the disk which is currently selected in the catalog window . A dialog is presented which 
allows you to enter a new comment. If you wish to delete an already existing comment simply 
delete all the characters by pressing the backspace key when the dialog first appears and 
then select "OK". 

Process File 

Selecting the Process File option displays a dialog box which allows you to specify actions to 
take against the file which is currently selected in the search window or a disk window . For 
further information see the section processing files . Note that selecting this menu command 
is equivalent to double-clicking on a file in a search or disk window. 
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View Menu Commands 

Volume Contents 

Selecting the Volume Contents command will create a new disk window which will display the 
contents of the currently selected volume in the catalog window. 

Archive Internals 

Selecting the Archive Internals command will create a new search window which will display 
the contents of the currently selected archive file in the disk window or search window which 
currently has the focus . If the currently selected file is not an archive then the menu option 
will not be available. 

Statistics 

Selecting the Statistics command will display a dialog box which will give statistical details of 
the catalog window or disk window or  search window which currently has the focus. 

Merge File Correlation 

Selecting the Merge File correlation command will  display a dialog box which will  give a 
cross-reference of the volume numbering in the catalog window to the catalog files they are 
associated with. This option is only available after a catalog merge has been undertaken. 
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Search Menu Commands 

Simple Search 

Selecting the Simple Search command will display a Dialog Box in which you can enter a 
filename pattern to search the catalog for. The search argument you enter can include the 
standard DOS wildcards * and ?. The results of the search will appear in a search window ,  
from where you can process any of the resulting files. 

Complex Search 

Selecting the Complex Search command will display a Dialog Box in which you can enter a 
combination of arguments (one or more) on which to base the search of the catalog. The 
search arguments are combined on an AND basis,  i.e.  a file must meet all  the specified 
arguments to be included. Possible arguments include:- 

The filename pattern  to  search  the  catalog  for.  The search  argument  you enter  can 
include the standard DOS wildcards * and ?. 

The minimum file size (in bytes). 

The maximum file size (in bytes). 

The  earliest  filedate.  The  format  of  date  required  depends  on  the  setting  in  the 
International section of the Windows Control Panel . If you are having trouble entering 
dates  an  incorrect  setting  in  Windows is  probably  the  reason.  You can change date 
formats at any time. 

The latest filedate. 

The results of the search will appear in a search window , from where you can process any of 
the resulting files. 
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Options Menu Commands 

Catalog Sort Order 

Selecting the Catalog Sort Order command presents a further sub-menu which allows the 
specification of the sort order required for the catalog window . If the catalog window currently 
has the focus then the new sort order will take effect immediately. If another window has the 
focus, then the new sort order will take effect when the catalog window gains the focus.  The 
specified sort order also affects the order in which entries will be printed 
or copied to the Windows Clipboard . 

Sorting is possible by volume number, volume name, volume freespace or by the date the 
volumes were cataloged. 

Disk Sort Order 

Selecting  the  Disk  Sort  Order  command  presents  a  further  sub-menu  which  allows  the 
specification of the sort order required for the disk window(s) . If a disk window currently has 
the focus then the new sort  order will  take effect immediately.  If  another window has the 
focus, then the new sort order will take effect as disk window(s) gain the focus.  The specified 
sort order also affects the order in which entries will be printed or copied to the Windows 
Clipboard . 

Sorting is possible by file name, file extension, file size, file date or directory name. 

Search Sort Order 

Selecting the Search Sort Order command presents a further sub-menu which allows the 
specification of the sort order required for the search window(s) . If a search window currently 
has the focus then the new sort order will take effect immediately. If another window has the 
focus, then the new sort  order will  take effect  as search window(s) gain the focus.  The 
specified sort order also affects the order in which entries will be printed or copied to the 
Windows Clipboard . 

Sorting is possible by file name, file extension, file size, file date, disk name, disk number or  
directory name. 

Catalog Display Style 

Selecting the Catalog Display Style command presents a further sub-menu which allows the 
specification of the display style required for the catalog window . The available options are to 
display disk comments, or to display data about the disk such as freespace, time and date of 
cataloging etc. If the catalog window has the focus then the new sort order will take effect 
immediately.  If  another window has the focus, then the new sort  order will  take effect as 
search window(s) gain the focus. 
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Window Menu Commands 

The Window menu subcommands implement the normal window management commands for 
MDI windows , with some extensions particularly relevant to SmartCat. For further information 
about general window management refer to your Windows documentation. 

Cascade 

Selecting Cascade re-arranges all non-minimized windows in an overlapping fashion. 

Tile 

Selecting Tile re-arranges all non-minimized windows in a tiled fashion, where all the space in 
the client window is used, but no windows overlap each other. 

Tile on Top (Windows 3.1 only). 

Selecting Tile on Top re-arranges all non-minimized windows in a tiled fashion, where all the 
space in the client window is used, but no windows overlap each other. With Windows 3.1 the 
windows are arranged with priority given to a horizontal arrangement. With Windows 3.0 the 
effect is the same as the "Tile" option. 

Arrange Icons 

Selecting Arrange Icons causes any minimized (iconised) windows to re-arrange themselves 
neatly at the bottom of the client window. 

Minimize all Windows 

Selecting Minimize all Windows causes all open windows to assume the minimized (iconised) 
state. 

Restore all Windows 

Selecting Restore all Windows causes all minimized windows to assume the normal state. 

Close all Search Windows 

Selecting Close all Search Windows causes all  search windows (minimized, maximized or 
normal) to close. 

Close all Disk Windows 

Selecting Close all Disk Windows causes all  disk windows (minimized, maximized or normal) 
to close. 

Close all Windows except Catalog 

Selecting Close all Windows except Catalog causes all open windows (except the  catalog 
window ) to close. You cannot close the catalog window. 
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Processing Files 

Once you have located the file(s) you are interested in, either in a disk window or a search 
window you can process the file in a number of ways. Having put the disk in question into the  
drive (unless the file is on a hard disk) double clicking on the file name will present a dialog 
box from where you can specify what action you wish to take. 

The dialog box that is presented details at the top the name of the file, the number of the disk 
it is on, the volume label (if it has one), and the default drive in which it expects to find it. 

To the right of the dialog box is a list box showing the available drives on your system, and 
you can select an alternative drive from which to process the file if desired.

To the left of the dialog box is another list box, and just above it the words "Target Path:-". The  
target path defines where any action which creates a further file or files will place those files. 
For example, the "Explode" option, which extracts all the files from an archive, will place the 
resultant files as specified by the "Target Path" specification. You can change the target path 
specification by use of the list box. The target path you specify is remembered from session to 
session. 

Slightly to the right of the centre of the dialog box are two on/off toggle options. Minimize on 
Use, if checked, causes SmartCat to shrink to an icon if another program is launched by use 
of the Run or Process buttons. Confirm Deletes, if  checked, issues a warning before any 
destructive operation is undertaken on any file.

Towards the bottom of the Dialog Box are a group of  process-option buttons.  The first  9 
provide different options, and are enabled and disabled as appropriate for the type of file  
selected. If the selected file is part of an archive, the text of some of the buttons will change to 
be preceeded by an "X" signifying that the file will first be extracted from its archive to the 
target path before the action is undertaken.

Delete will attempt to delete the file. 

Rename will attempt to rename the file. 

Copy will attempt to copy the file to the specified target path. 

Move will attempt to copy the file to the specified target path, and then delete the original. 

Run (which is only enabled if the file is executable), will attempt to execute the file. 

Process (which is only enabled if the file is associated with a particular program (use the File  
Manager  File|Associate  option  to  associate  files  to  programs)  -  see  your  Windows 
documentation) attempts to launch the associated program with this file as its input.

Extract attempts to extract this file from the archive it is in to the target path. This option is  
only enabled if the file is in an archive. 

Explode attempts to extract all the files from this archive to the target path. This option is only 
enabled if the file is itself an archive. 

Print attempts to print the file to the current Windows printer.
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The remaining buttons are user-definable. For more information see the customization details 
section. 
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Customisation Details 

SmartCat can be customised to suit your needs, and the way you like your system to work. 
The main areas where you can customise SmartCat are in the way it performs pre-catalog 
virus scanning, the way it performs extraction from archives, and what effect pressing any of 
the "User" buttons in the Process File dialog box has. All are customised by modifying the 
SMARTCAT.INI file which is distributed with the product. 

Pre-Catalog Virus Scanning 

In your SMARTCAT.INI file you will find the following line:- 

ExSCAN=SMCATDOS.BAT SCAN %d /NOMEM 

The detail after the = sign is the command SmartCat will issue to cause a virus scan of the 
disk. The %d parameter will be replaced with the drive designation (e.g. a:) for the drive to be 
used for cataloging. As delivered SmartCat will call the supplied SMCATDOS.BAT file which in 
turn will call the McAFee Scan program with the memory checking option disabled. Note that 
the  SCAN  program  is  not  supplied  as  part  of  SmartCat,  but  is  available  from  all  good 
shareware sources. If required you can modify this command to suit your needs, perhaps by 
calling an alternative virus scanner. 

Archive Processing 

In your SMARTCAT.INI file you will find the following 5 lines:- 

ExZIP=SMCATDOS.BAT PKUNZIP -O 
ExLZH=SMCATDOS.BAT LHA E /C 
ExARC=SMCATDOS.BAT ARC-E 
ExPAK=SMCATDOS.BAT PAK E 
ExARJ=SMCATDOS.BAT ARJ E 

Each of these lines represents the beginning of the command that SmartCat will  issue to 
invoke the relevant archive extraction program. SmartCat appends the archive file name and 
target path name as required. If you wish you can modify these commands to more suit your 
way of working. For example you may wish to use the "ARC" program to extract "ARC" files 
rather than the "ARC-E" program which is the default. If so modify the ExARC line to read 
"ExARC=SMCATDOS.BAT ARC E ". Similarly, the commands above assume the extraction 
programs can be found somewhere in a directory in your PATH . If this is not the case you 
may  wish  to  add  drive/directory  information  to  these  commands.  Note  that  the  archive 
extraction programs are not  supplied as part  of  SmartCat,  but  all  are freely  available as 
shareware from good shareware sources. 

Defining "User Buttons" 

In your SMARTCAT.INI file you will find pairs of the following type of lines:- 

User1Btn=&View 
User1Cmd=Notepad.exe %f 

The UsernBtn= line defines, for each user button, what will appear on the button face. The & 
immediately preceeds the character which will become the button's "hot-key" (although there 
aren't many left to choose from, and if you duplicate one that already exists in the dialog box 
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the  original  will  take  precedence).  If  the  file  is  actually  in  an  archive,  SmartCat  will 
automatically add the character X to the start of the button text (and will extract the file first if 
you push the button!) 
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The User1Cmd line defines what command will be issued when the button is pressed. In the 
command the characters %f can be used and SmartCat will insert the name of the file at that  
point. The characters %t can be used to indicate the target pathname selected in the process 
file dialog box. 

For  example,  assuming you had a super-wizzo editor  called WIZZO, and you wanted to 
modify user button 3 to call it, you would need something along these lines:- 

User3Btn=&Wizzo 

User3Cmd=WIZZO %f

Note  that  as  delivered  the  first  user  button  has  been set  up  as  &View,  and it  calls  the 
NOTEPAD program. The second user button has been set to call the McAFee virus scanning 
program SCAN via the SMCATDOS.BAT interface batch file. All the other user buttons are set 
up to call the WRITE program. 
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Problem Determination 

SmartCat  has  gone  through  a  thorough  testing  process,  but  like  any  complex  piece  of 
software there may be the odd bug still lurking. SmartCat also depends to some extent on the 
integrity of the data (i.e the disks, and the files thereon) that are presented to it to catalog. 

If you discover a problem there are some things you can do to help narrow down the cause:- 

If the problem occurs while cataloging a disk first determine if the disk is actually readable by 
the DOS DIR command (or the Windows File Manager).  If  they can't  read it,  it  is almost  
certain the Directory Structure is corrupt. If the disk can be read OK by a DIR command and 
the Windows File Manager, try cataloging the disk again with SmartCat but having turned 
OFF all the archive analysis checkboxes. If SmartCat can now cope with the disk it is almost 
certain that one of the archive files on the disk is corrupt. A process of elimination, together 
with careful observation of the message box in the Add Disk Dialog box should enable you to  
narrow the problem down to a specific file. Once you have determined which file causes the 
problem try  to  process it  with  its  native utility  and produce a list  of  the files the archive 
contains. If this also fails you don't have many choices, either attempt to repair the archive 
(some archives, like ZIP files, have a matching repair utility (PKZIPFIX)) or try and extract 
what you can before you scrap it. 

If DIR and the Windows File Manager can cope with the disk, and there do not appear to be 
any corrupt archives, please contact us for advice. We may already have a fix, or we may ask 
you to send us the offending disk/file for further investigation. 

If you have any other problem with SmartCat not related to cataloging disks please let us 
know and we will do our best to resolve them. 
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